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1. Introduction

The Railroad Traffic Planner is a computerized planning tool designed to help railroad employees more effectively create and evaluate schedules.  It can also be used to view near-real-time train location information when a Global Positioning System (GPS XE "GPS" ) tracking system is incorporated.  The U.S. Department of Transportation’s Research and Special Program Administration’s John A. Volpe National Transportation System Center, and the Massachusetts Institute of Technology (MIT) created this software for a project sponsored by the Federal Railroad Administration’s Human Factors Research and Development Program.  Fulcrum Corporation contributed to the development of a GPS tracking module as part of an effort to deploy the software at additional railroads.  This application is proof-of-concept software developed to identify the potential benefits of this type of tool.  It is for demonstration and evaluation purposes only, and should not be used for safety critical operations.  

1.1 Background

Creating and modifying schedules are some of the most difficult tasks in railroad operations.  Making and assessing the impacts of small changes to a schedule on paper can often take many hours, which means that traffic planners rarely have the time to explore schedule alternatives and find the “best” solutions.  Dispatching tools show where trains are now, but planners need to determine the operational sequence of future events, and answer questions such as:  Who will arrive where and when?  When and where trains will interfere with each other?  How could the flow best be managed?

Stringline diagrams, which show the time and locations of scheduled trains, have been used in the railroad industry for many years to support railroad traffic planning.  Traditional techniques for creating strings included stretching actual string along a tack board or drawing them with a pencil on paper.  The Railroad Traffic Planner is a visualization tool with computerized strings, so traffic planners can quickly demonstrate the impact of changes and create better schedules compared to the conventional method of hand-drawn strings.  

A GPS XE "GPS"  tracking system can also be incorporated with the Railroad Traffic Planner to create strings based on train positions identified by the GPS device.  This helps the railroad employees better assess the progress of the trains and plan for the future.  Rather than drawing all of their strings from scratch, they can use actual position data in their planning activities. 

Some computer applications already provide string diagrams and tracking system displays, but they are generally too expensive and have too many features for the smaller railroads to acquire and use on a regular basis.  The intent of this project is to determine the benefits that can be achieved by providing planners with a simple visualization tool to assist them in the schedule-making process.  The Railroad Traffic Planner was designed specifically for planners that currently have little or no computerized scheduling support and lack the resources for the types of applications that are currently available.

1.2 Using This Guide

The topics in this guide have been included in a sequence that could serve as a tutorial for typical usage, but it is probably best to become comfortable with the features explained in Section 3 before making too many modifications to the text files described in Section 2.  The Table of Contents and many of the descriptions contain hyperlinks that can be clicked to navigate to other parts of this document where the specific topics are described.  The hyperlinks are shown in underlined text.  A glossary and index are also provided at the end of the document.

1.3 Railroad Traffic Planner Overview XE "Overview"  Diagram

The following diagram shows some key components of the Railroad Traffic Planner.  Click on the image or label to go to a description of the feature. 
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2. Set Up

2.1 Installation XE "installation" 
2.1.1 System Requirements XE "system requirements" 
The following recommendations are guidelines for using the Railroad Traffic Planner:

· Pentium 3 or Celeron or better

· At least 256MB RAM (512MB recommended) 

· Display adapter and monitor capable of showing 1024x768 pixels (1280x1024 pixels recommended).  Note: the Microsoft Windows task bar must be hidden to view the bottom of the display.

· At least 200MB of free disk space on C:\ drive 

· Microsoft Windows XP or Windows 2000
2.1.2 Installing Java XE "Java"  Runtime
The Railroad Traffic Planner has been written in Java XE "Java" , and requires Java XE "Java"  2 SDK v.1.4.1_02, which is provided on the CD, to operate effectively.  Double-click on the file called j2sdk-1_4_1_02-windows-i586 and follow the prompts to install it.
2.1.3 Installing the Railroad Traffic Planner
To install the Railroad Traffic Planner application, double-click on the file called Railroad Traffic Planner Installation, and press the Unzip button.  The files will automatically be placed in the C:\StringLineInterface directory.

2.1.4 Setting Up the Railroad Traffic Planner.bat XE "Railroad Traffic Planner.bat"  File and Launching the Application
Place the Railroad Traffic Planner.bat XE "Railroad Traffic Planner.bat"  file (which has this icon:[image: image2.jpg]


) on the desktop by copying it from the install CD.

To launch the Railroad Traffic Planner application, double-click on the Railroad Traffic Planner.bat XE "Railroad Traffic Planner.bat"  file.

2.2 Creating Text Files for Railroad-Specific Settings

The Railroad Traffic Planner application uses data from several tab delimited text files to define characteristics that vary from one railroad to another, such as the track XE "tracks"  configuration XE "track configuration" , train types, and typical train speeds XE "speeds" .  These files are located in the folder C:\StringLineInterface\RailSpecificFiles.  Sample versions have been included on the installation CD. 
2.2.1 Defining the Default View and Rail Map XE "Rail Map"  Characteristics Using BasicSettings.txt XE "BasicSettings.txt"  

The first twelve rows in the BasicSettings.txt XE "BasicSettings.txt"  file provide settings for default values, which specify how some of the areas of the application will display, and which values will pre-fill in certain fields.  The other rows relate to the Rail Map" Rail Map
, which is a diagram representing the track XE "tracks"  network for the railroad.  

The following diagram shows a sample BasicSettings.txt XE "BasicSettings.txt"  file with the various sections marked.
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The TRACKINGFEATURESON setting should only be set to Y (yes) if the GPS XE "GPS"  tracking system has been installed at the railroad (see Section 2.3 for more details).  This will provide access to the features associated with displaying the GPS tracking data.  If the railroad has not installed the GPS tracking system for this application, this should be set to N (no) so that the options will be disabled, which will prevent people from accidentally trying to use them.  The next three rows are only relevant if the tracking features are available.  The GPS server name should be entered next to the TRACKINGSERVER label and the GPS port ID should be entered next to the TRACKINGPORT label.  If the GPS tracking system has not been installed, an “X” should be entered for both.  The DEFAULTTRACKINGSTARTTIME specifies the time (using today’s date) of the earliest GPS tracking data that automatically displays when the application is first opened (a number must be entered here, even if the GPS tracking system is not included).

The DEFAULTSLIDERSTARTHOUR and DEFAULTSLIDERENDHOUR define the time period included in the Time Slider XE "Time Slider" , which is used to control the time period visible in the String View" String View
 area.  For these hour numbers, 0 is midnight for Day 0 (or today if TRACKINGFEATURESON is set to Y), and all other numbers should be calculated in relation to that number. The application is set up to support three days, so any hours from 0 to 72 should be acceptable. 
The DEFAULTSTRINGVIEWSTARTHOUR and DEFAULTSTRINGVIEWENDHOUR define which hours are visible in the String View" String View
 area when the application is first opened and when the view is reset.  Like the previous two fields, the number 0 represents midnight on Day 0 (or today if TRACKINGFEATURESON is set to Y) and all of the other numbers should be calculated in relation to that number.  

SELECTALLSTOPS should be set to Y (yes) if all of the primary waypoints
 XE "waypoints"  should be defaulted as stops when adding trips XE "trips" .  If the stops should not be defaulted, set this field to N (no).  The DEFAULTDWELLTIME field controls how long the dwells will be when a stop checkbox is initially checked in the Add Trip XE "Add Trip" , Update Trip XE "Update Trip"  and Copy Trip XE "Copy Trip"  windows (the value can be changed to a different dwell length for a particular location, if needed).

When adding track restrictions XE "track restrictions" , the days and times that pre-fill in the Add Track Restriction XE "Add Track Restriction"  window are defined by the DEFAULTRESTRICTIONSTARTDAY, STARTRESTRICTIONSTARTTIME, DEFAULTRESTRICTIONENDDAY, DEFAULTRESTRICTIONENDTIME fields.  The two times should be in hhmm military time format (such as 0600 for 6:00 am or 1300 for 1:00 pm).  It is okay if the leading zeros are missing.  The days should be entered as a number from 0 to 2 (0 is today if TRACKINGFEATURESON is set to Y). 

Several fields in BasicSettings.txt relate to the Rail Map
, which displays all of the lines included for the railroad.  Before setting up the BasicSettings.txt file, create two JPEG images of the railroad network.  The larger image, which will be identified in the RAILMAPIMAGEFILE field, should be roughly 620 by 550 pixels and the smaller one, which will be defined in the RAILMAPSTANDINIMAGEFILE field, should be roughly 115 by 75 pixels.  The layout of the railroad network should be simplified as much as possible to minimize the amount of effort required to enter the relevant pixel coordinates in the BasicSettings.txt XE "BasicSettings.txt"  file.  The DEFAULTRAILLINENUMBER field shows which of the lines specified in the list below it will initially display when the application is first opened.  This counts down the list starting with 0 for the first line in the list.  RAILLINEFILES indicates how many different lines are included.  The name of the file for each line that identifies the track and speed XE "speeds"  information begins with “WaypointsPositionsTracksSpeeds_” and then the line name.  One SELECTIONRECT must be defined for each line.  This is the part of the Rail Map can be clicked to select that line.  When clicking on the SELECTIONRECT area of the Rail Map, green lines will display as defined by the subsequent rows in the BasicSettings.txt file.  These green lines can be defined using as many segments as necessary.  Each segment is defined using the terms LeftDiag (left diagonal), RightDiag (right diagonal), Horizontal, or Vertical to control the direction of the lines.  

2.2.2 Defining Lines with WaypointsPositionsTracksSpeeds_name.txt XE "WaypointsPositionsTracksSpeeds_name.txt" 
In this application, a line is a series of waypoints XE "waypoints"  and the corresponding tracks XE "tracks"  and sidings XE "sidings" .  A file must be set up for each line in the application and referenced in the BasicSettings.txt" BasicSettings.txt 
 file.  

The names for these files must consist of the characters “WaypointsPositionsTracksSpeeds_” then the line name.  

The following diagram shows a sample WaypointsPositionsTracksSpeeds_name.txt XE "WaypointsPositionsTracksSpeeds_name.txt"  file with the various sections marked.
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The DOWNLABEL defines the word that displays as the Direction for going down the list in the Add Trip XE "Add Trip" , Update Trip XE "Update Trip"  and Copy Trip XE "Copy Trip"  windows, and the UPLABEL defines the word that displays as the Direction for going up the list.

NUMTRACKS currently must be set to 3.

NUMTRAINTYPES defines how many train types are included in this file.

TRAINTYPENAME should begin with either “Freight-” (with the hyphen) or “Passenger”.

A different SPEEDCHANGEDISTANCE can be defined for freight and passenger trains.  Although there can be several train types within these two categories, there can only be one SPEEDCHANGEDISTANCE for all freight trains and one SPEEDCHANGEDISTANCE for all passenger trains.  The one that is included last in the file (furthest to the right) for each category is the one that is used by the application.  Note:  Speeds sometimes calculate incorrectly when the SPEEDCHANGEDISTANCE XE "WaypointsPositionsTracksSpeeds_name.txt"  is less than 0.01.

The valid values for the USED column are:

· Y – Yes, this waypoint XE "waypoints"  should be visible in the application

· N – No, this waypoint XE "waypoints"  should not be visible in the application

The valid values for the PRIMARYORSECONDARYWAYPOINT column are:

· P – Primary, a more important waypoint, such as where the trains stop XE "waypoints"  (see glossary for more details) XE "primary waypoints" 
· S – Secondary, a less important waypoint XE "waypoints"  (see glossary for more details) XE "secondary waypoints" 
The WAYPOINTNAME column contains the list of meaningful locations along the tracks XE "tracks" , which can include stations, interlockings, milepost numbers, grade crossings and bridges.  Include all locations where trains are likely to stop and speeds XE "speeds"  are likely to change.  The exact same name may not be included more than once in the list.

For each waypoint XE "waypoints" , specify the corresponding mile number in the MILENUMBER column.  The mile numbers can count forwards or backwards, but they must go down the list in sequence, and no number can be included more than once.

The TRACKS column uses the following coding system, which requires that the siding XE "sidings"  and track XE "tracks"  designations come in pairs of start and end points: 

· TLS – Left track XE "tracks"  start

· TLE – Left track XE "tracks"  end

· T2S – Middle track XE "tracks"  start

· T2E – Middle track XE "tracks"  end 

· TRS – Right track XE "tracks"  start

· TRE – Right track XE "tracks"  end 

· SLS – Left siding XE "sidings"  start

· SLE – Left siding XE "sidings"  end

· SRS – Right siding XE "sidings"  start

· SRE – Right siding XE "sidings"  end 

· XXX – No sidings XE "sidings"  or tracks XE "tracks"  begin or end at that waypoint XE "waypoints" 
The SWITCHES column uses the following coding system for defining where the connections between the tracks XE "tracks"  and sidings XE "sidings"  should be:  

· SU12 – Switch XE "switches"  goes up from first (left) to second (middle) track XE "tracks"  

· SD12 – Switch XE "switches"  goes down from first (left) to second (middle) track XE "tracks" 
· SD23 – Switch XE "switches"  goes down from second (middle) to third (right) track XE "tracks" 
· SU23 – Switch XE "switches"  goes up from second (middle) to third (right) track XE "tracks" 
· XXXX – No switch exists at that waypoint XE "switches" 

 XE "waypoints" 
The columns for defining the speeds XE "speeds"  are labeled based on the direction of the trains they will influence (DOWN if the train will travel in the direction going down the waypoint XE "waypoints"  list and UP if the train will travel in the direction going up the waypoint list XE "Outbound" ) and the track XE "tracks"  to which the speed will apply (1 is the left track XE "tracks" , 2 is the middle track XE "tracks" , 3 is the right track XE "tracks" ).  If no track XE "tracks"  exists for that position, the speed value should be set to 0.  See Appendix A for additional information on how the speeds are calculated for the strings.

The DOWNDEFAULT and UPDEFAULT columns use the following coding system for determining which track will be the default track for trains traveling in the particular direction:

· TL – Left track XE "tracks"  

· T2 – Middle track XE "tracks" 
· TR – Right track XE "tracks" 
2.3 Setting Up the GPS XE "GPS"  Tracking Components

The Railroad Traffic Planner can display vehicle position information from a GPS XE "GPS"  tracking system that has been installed on railroad equipment, such as locomotives and maintenance vehicles.  Fulcrum Corporation has been investigating a number of ways to build the tracking components of the system.  The initial prototype at North Shore Railroad in Pennsylvania uses a GPS-enabled, programmable cellular phone, which has been packaged to withstand the shock and temperature extremes of the railroad environment.  This is mounted on the exterior of a locomotive, so that the GPS satellite and cellular signals are not blocked.  The power cable for the phone is connected to a battery pack connected to the locomotive power supply, and the phone is programmed to collect the GPS data and transmit it at certain intervals (roughly every minute when the train is moving and every hour when it is stopped) to a database on a server at Fulcrum Corporation.  The Railroad Traffic Planner application retrieves the GPS time and position data through an Internet connection when the TRACKINGFEATURESON setting in the BasicSettings.txt" BasicSettings.txt 
 file is set to Y.  More details about the GPS functionality within the Railroad Traffic Planner application are included in Section 3.5 of this document.

3. Using the Railroad Traffic Planner

3.1 The Rail Map XE "Rail Map" 
The Rail Map XE "Rail Map"  allows you to select the line with which you will be working.  (Section 2.2.1 describes how to set up a Rail Map to match the layout of a particular railroad using the BasicSettings.txt" BasicSettings.txt 
file XE "BasicSettings.txt" .)  

When you click on a green circle at the end of a line on the Rail Map XE "Rail Map" , the default schedule
 for that line will display in the String View" String View
 area of the main window of the application.

A sample Rail Map XE "Rail Map"  is shown below with the “Thomson” line selected.
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3.2 String View XE "String View"  Navigation

The String View XE "String View"  area is the section of the display where the strings representing train trips XE "trips"  and track XE "tracks"  restrictions XE "track restrictions"  are shown within the Railroad Traffic Planner.  It takes up the majority of the main application window.  There is a scale for time across the top and a scale for location (mile numbers, tracks XE "tracks" /sidings XE "sidings" , and waypoint XE "waypoints"  names) down the left-hand side.  An example is shown below.
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The top part of the String View XE "String View"  area indicates the days and hours visible in the display (based on the position of the Time Slider" Time Slider
, which can be used to adjust the time interval displayed on the screen).  The default length of time displayed in the String View area when the application is first opened or the view is reset is defined in the BasicSettings.txt" BasicSettings.txt 
file using the DEFAULTSTRINGVIEWSTARTHOUR and DEFAULTSTRINGVIEWENDHOUR fields.  When TRACKINGFEATURESON is set to Y in the BasicSettings.txt" BasicSettings.txt 
file
, actual dates will display along with the “Day” numbers.

The left side of the String View XE "String View"  area shows information about the tracks XE "tracks"  including the mile numbers, a pictorial image of the tracks and sidings XE "tracks" 

 XE "sidings" , and waypoint XE "waypoints"  names.  (The track information that is visible is based on the position of the Track Slider" Track Slider
 XE "tracks" , which can be used to adjust the section of track displayed on the screen.)  Notice that some waypoint XE "waypoints"  names are a darker color than the other ones.  The darker ones are called primary waypoints
, and the other ones are known as secondary waypoints
.  (See the glossary for more information on the differences between the two types of waypoints.)  In the image above, many of the waypoint names are difficult to read, because they overlap.  Zooming in on a certain section of track will move the waypoint names further apart, so they are easier to read.  

The center of the String View XE "String View"  area contains strings, which are colored lines connecting times and locations for train trips XE "trips"  that are scheduled.  In the image above, there is a string called ABCD, which represents a trip that leaves DannyWest around 9:00 and arrives at OldBeach around 12:00.  
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Valuable information about train positions and relative speeds can be determined without complex calculations by looking at the strings.  Here are some examples based on the image above:

· When the string is a horizontal line, such as at HydePark, the train will be stopped (since the location is not changing while time passes).  In the Railroad Traffic Planner application, the stops (dwells) are a different color than the rest of the string, to further emphasize them.  

· The length of the horizontal line compared to the time scale indicates how the long the train will be stopped (30 minutes in the example above).    

· The slope of the line indicates the relative speed of the train.  The segments with steeper slopes are faster.  In the example above, train ABCD will go faster from HydePark to Mansfield than from Mansfield to Attleboro.

· The direction can also be determined from the slope, by looking at whether the string is going up or down as it goes forward in time (towards the right side of the display).  The train labeled ABCD will go towards Providence and the train labeled EFGH will go away from Providence.

· Intersecting lines indicate that trains will be in the same location at the same time.  This is generally fine if they are on separate tracks, but a big problem if they are on the same tracks.  Examining the meets and passes (easily identified by the X’s on the display) can help users identify problem areas.

· Unlike schedule tables, strings show times for entire trips, not just the stops.  This can be useful if the time at a point without a stop (such as an interlocking) needs to be determined.

While using the Railroad Traffic Planner, it is often useful to focus in on a certain time or location.  Therefore, there are several ways to zoom XE "zoom"  and pan XE "pan"  to a specific area of the overall view, which are described in the following sections.

3.2.1 Click and Drag Zooming XE "Click and Drag Zooming" 
To zoom XE "zoom"  in on the time and location simultaneously, click (using the left mouse button) on the background of the String View XE "String View"  area at the desired starting time and location, and then drag the cursor to the desired ending time and location.  A rectangular shape will display, as shown in the image below, to indicate the section that will be visible when the mouse button is released.  


Once the mouse button is released the String View XE "String View"  area displays only the section that was included in the rectangle, as shown in the following image.
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3.2.2 The Time Slider XE "Time Slider" 
The Time Slider XE "Time Slider"  shows days and hours.  It has a lighter section that indicates which part of the overall time scale is currently displayed in the String View XE "String View" .  The lighter section can also be dragged around and resized to adjust the visible time interval.

The number of hours included in the Time Slider XE "Time Slider"  is defined in the BasicSettings.txt" BasicSettings.txt 
file using the DEFAULTSLIDERSTARTHOUR and DEFAULTSLIDERENDHOUR fields.  When TRACKINGFEATURESON is set to Y in the BasicSettings.txt" BasicSettings.txt 
file
, actual dates will display in addition to the “Day” numbers (which are shown in the image below).
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Zooming XE "zoom"  with the Time Slider XE "Time Slider" 
When the arrows at the edges of the Time Slider XE "Time Slider"  (
[image: image10.png]


 and 
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) are dragged toward the center of the Time Slider, the time interval displayed decreases.  Dragging the Time Slider arrows away from the center of the Time Slider increases the displayed time interval.

Panning XE "pan"  with the Time Slider XE "Time Slider" 
When the center section of the Time Slider XE "Time Slider"  is dragged right or left, the view pans in the corresponding direction.  

3.2.3 Zooming XE "zoom"  and Panning XE "pan"  the Time Incrementally

There are several other ways to adjust the time interval, which are especially helpful when only a small change is desired.  

Zooming XE "zoom"  Time Incrementally

To zoom XE "zoom"  in in small increments to show a shorter period of time:

1. Right mouse click in the String View" String View
 area and select Adjust View, and then choose Zoom XE "zoom"  Time In
OR

2. Press the Zoom XE "zoom"  Time In button: 
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OR

3. Select Adjust View from the View menu, and then choose Zoom XE "zoom"  Time In 

To zoom XE "zoom"  out in small increments, to show a longer period of time:

4. Right mouse click in the String View" String View
 area and select Adjust View, and then choose Zoom XE "zoom"  Time Out
OR

5. Press the Zoom XE "zoom"  Time Out button: 
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OR

6. Select Adjust View from the View menu, and then choose Zoom XE "zoom"  Time Out 
Panning XE "pan"  Time Incrementally

To pan XE "pan"  the visible time interval to the left in small increments:

7. Right mouse click in the String View" String View
 area and select Adjust View, and then choose Pan XE "pan"  Time Left
OR

8. Press the Pan XE "pan"  Time Left button: 
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OR

9. Select Adjust View from the View menu, and then choose Pan XE "pan"  Time Left 

To pan XE "pan"  the visible time interval to the right in small increments:

10. Right mouse click in the String View" String View
 area and select Adjust View, and then choose Pan XE "pan"  Time Right
OR 

11. Press the Pan XE "pan"  Time Right button: 
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OR

12. Select Adjust View from the View menu, and then choose Pan XE "pan"  Time Right 

3.2.4 The Track XE "tracks"  Slider XE "Track Slider" 
The Track XE "tracks"  Slider XE "Track Slider"  has a lighter section that indicates which part of the overall track XE "tracks"  is currently displayed in the String View" String View
 area XE "String View" .  The lighter section can also be dragged up and down or be resized to adjust the visible track XE "tracks"  section.
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Below is an image that shows the track XE "tracks"  zoomed in.  Notice that the String View" String View
 area only contains the section shown in the Track XE "tracks"  Slider XE "Track Slider"  (which, in this case, includes Graydon and Larry, but not the other primary waypoints
 XE "waypoints" ).
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Zooming XE "zoom"  with the Track XE "tracks"  Slider XE "Track Slider" 
When the arrows at the top and bottom of the Track XE "tracks"  Slider XE "Track Slider"  ([image: image18.jpg]


 and [image: image19.jpg]


) are dragged toward the center of the Track XE "tracks"  Slider, the length of track XE "tracks"  displayed decreases.  Dragging the Track XE "tracks"  Slider arrows away from the center of the Track XE "tracks"  Slider increases the length of track XE "tracks"  displayed.

Panning XE "pan"  with the Track XE "tracks"  Slider XE "Track Slider" 
When the center section of the Track XE "tracks"  Slider XE "Track Slider"  is dragged up or down the view pans in the corresponding direction.  

3.2.5 Zooming XE "zoom"  and Panning XE "pan"  the Track XE "tracks"  Area Incrementally

There are also several other ways to adjust the visible length of track XE "tracks" , which are especially helpful when only a small change is desired.  

Zooming XE "zoom"  Track XE "tracks"  Incrementally

To zoom XE "zoom"  in in small increments to show a smaller section of track XE "tracks" :

13. Right mouse click in the String View" String View
 area and select Adjust View, and then choose Zoom XE "zoom"  Track XE "tracks"  In
OR 

14. Press the Zoom XE "zoom"  Track XE "tracks"  In button:
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OR

15. Select Adjust View from View menu, and then choose Zoom XE "zoom"  Track XE "tracks"  In 
To zoom XE "zoom"  out in small increments to show a larger section of track XE "tracks" :

16. Right mouse click in the String View" String View
 area and select Adjust View, and then choose Zoom XE "zoom"  Track XE "tracks"  Out
OR 

17. Press the Zoom XE "zoom"  Track XE "tracks"  Out button: 
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OR

18. Select Adjust View from the View menu, and then choose Zoom XE "zoom"  Track XE "tracks"  Out 

Panning XE "pan"  Track XE "tracks"  Incrementally

To pan XE "pan"  the visible track XE "tracks"  area up in small increments:

19. Right mouse click in the String View" String View
 area and select Adjust View, and then choose Pan XE "pan"  Track XE "tracks"  Up
OR 

20. Press the Pan XE "pan"  Track XE "tracks"  Up button: 
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OR

21. Select Adjust View from the View menu, and then choose Pan XE "pan"  Track XE "tracks"  Up 

To pan XE "pan"  the visible track XE "tracks"  area down in small increments:

22. Right mouse click in the String View" String View
 area and select Adjust View, and then choose Pan XE "pan"  Track XE "tracks"  Down
OR 

23. Press the Pan XE "pan"  Track XE "tracks"  Down button: 
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OR

24. Select Adjust View from the View menu, and then choose Pan XE "pan"  Track XE "tracks"  Down
3.2.6 Resetting the View XE "reset view" 
There are several ways to reset the view XE "reset view"  to the original settings, which are defined using the DEFAULTSTRINGVIEWSTARTHOUR and DEFAULTSTRINGVIEWENDHOUR fields in the BasicSettings.txt" BasicSettings.txt 
file.  

Reset XE "reset view"  Track XE "tracks"  and Time

To reset XE "reset view"  both the track XE "tracks"  and time area displayed:

25. Right mouse click in the String View" String View
 area and select Adjust View, and then choose Reset XE "reset view"  Track XE "tracks"  and Time
OR 

26. Press the Reset XE "reset view"  Track XE "tracks"  and Time button: [image: image24.jpg]



OR

27. Select Adjust View from the View menu, and then choose Reset XE "reset view"  Track XE "tracks"  and Time 

Reset XE "reset view"  Time Only

To reset XE "reset view"  only the displayed time interval:

28. Right mouse click in the String View" String View
 area and select Adjust View, and then choose Reset XE "reset view"  Time Only
OR 

29. Press the Reset XE "reset view"  Time Only button: 
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OR

30. Select Adjust View from the View menu, and then choose Reset XE "reset view"  Time Only 

Reset XE "reset view"  Track XE "tracks"  Only

To reset XE "reset view"  only the displayed track XE "tracks"  area:

31. Right mouse click in the String View" String View
 area and select Adjust View, and then choose Reset XE "reset view"  Track XE "tracks"  Only
OR 

32. Press the Reset XE "reset view"  Track XE "tracks"  Only button: 
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OR

33. Select Adjust View from the View menu, and then choose Reset XE "reset view"  Track XE "tracks"  Only 

3.3 Trips and Strings

The Railroad Traffic Planner is used to prepare train schedules that show each hypothetical “trip XE "trips" ” that a train could take in the form of a “string,” which is a line connecting the relevant times and locations in the String View" String View
 area XE "trips" .  The difference between these “trips” and the “GPS XE "GPS"  strings” described in Section 3.5 is that the “trips” are modifiable, whereas the “GPS strings” reflect actual positions of equipment, which cannot be changed.

The Train ID XE "Train ID" , which is the set of letters and/or numbers used to identify the trip XE "trips" , is displayed at the beginning of each string.  When a trip is selected, its “stop handles XE "stop handles" ” are visible.  Stop handles are squares positioned at each waypoint XE "waypoints"  along the trip (and at certain speed changes).  Stop handles can be dragged to adjust times and speeds XE "speeds"  of the trip.  When the view is zoomed completely out, only the stop handles at primary waypoints XE "primary waypoints"  are visible on the selected trip.  A “baseline” can be set for each trip.  When a trip has a baseline XE "baseline"  and the trip is moved, the baseline stays in the original position to show where the trip was when the baseline was set.  

3.3.1 Adding Trips

In order to add a new trip to the String View XE "String View"  area, an Add Trip XE "Add Trip"  window must be accessed.  There are two Add Trip windows available.  One of them, called the Condensed XE "Condensed"  View, shows only some of the most critical information about the trip XE "trips" .  The other window, called the Extended XE "Extended"  View shows all of the aspects of the trip that may be specified.  Both of the windows are described in further detail below.

Add Trip XE "Add Trip"  Condensed XE "Condensed"  View
The Add Trip XE "Add Trip"  Condensed XE "Condensed"  View window is shown below.
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This view provides access to only the primary waypoints XE "primary waypoints" 

 XE "waypoints" , so that the most common trip XE "trips"  information can be added and viewed as quickly as possible.  This view does not provide information on the tracks XE "tracks"  used during the trip XE "trips"  or the speeds XE "speeds" , which are available in the Extended XE "Extended"  View.  When a trip XE "trips"  is added through the Condensed XE "Condensed"  View it may be updated and copied in the Condensed View as long as it has never been modified in the Extended XE "Extended"  View.  Once a trip has been manipulated using the Extended View, the Condensed View is no longer available, since it may not provide a complete enough representation of the trip details.

Add Trip XE "Add Trip"  Extended XE "Extended"  View
The Add Trip XE "Add Trip"  Extended XE "Extended"  View is shown below.
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This view provides access to all of the waypoints XE "waypoints" , including the primary XE "primary waypoints"  and the secondary waypoints XE "secondary waypoints" .  This is a much more comprehensive view that provides the ability to view and update the tracks XE "tracks"  used during the trip XE "trips" , and also shows the speeds XE "speeds"  for all of the legs of the trip XE "trips" .  When a trip XE "trips"  is added in the Extended XE "Extended"  View, it may not be updated or copied in the Condensed XE "Condensed"  View, since the Condensed View may not provide a complete enough representation of the trip details.

Accessing the Add Trip XE "Add Trip"  Windows

To access the Add Trip XE "Add Trip"  windows to create a new trip XE "trips" :

34. Right mouse click in the String View" String View
 area, select Add Trip XE "Add Trip" , and then choose either the Condensed 
or Extended XE "Extended"  View
OR

35. Press the Add Trip XE "Add Trip"  toolbar button [image: image29.jpg]


, and then choose either the Condensed 
or Extended XE "Extended"  View
OR

36. Select Add Trip XE "Add Trip"  from the Edit menu, and then choose either the Condensed 
or Extended XE "Extended"  View
Populating the Condensed XE "Condensed"  Add Trip XE "Add Trip"  Fields

Enter information in the following fields to add a trip XE "trips"  using the Add Trip XE "Add Trip"  Condensed XE "Condensed"  View window:

a) Enter the letters and/or numbers representing the trip XE "trips"  in the box labeled Train ID XE "Train ID" 
b) Indicate the type of train in the Type XE "Type"  dropdown box.  The various types available are defined in the WaypointsPositionsTracksSpeeds_name.txt XE "WaypointsPositionsTracksSpeeds_name.txt"  files

c) Select the train Direction.  The first option means that the sequence of waypoints XE "waypoints"  will be from the top of the list to the bottom (read down), and the second option means that the sequence of waypoints for the trip XE "trips"  will be from the bottom of the list to the top (read up).  The labels for these options are specified in the WaypointsPositionsTracksSpeeds_name.txt XE "WaypointsPositionsTracksSpeeds_name.txt"  files

d) Enter either the start or end time of the trip XE "trips"  in the Time field, and check the radio button for Start or End to indicate which time it is

e) Place checkmarks next to the start and end waypoints XE "start and end waypoints" 

 XE "waypoints"  for the trip XE "trips"  (only two checkboxes in this column should be checked at once).  The area to the left of these checkboxes shows the words Start and End to show how each checkmark has been interpreted.

f) Enter dwell XE "Dwell"  times for any waypoints XE "waypoints"  at which the train will stop.  The dwell XE "Dwell"  is the length of time that the train will be stopped.  Checking a Stop checkbox XE "Stop checkbox"  will enter the default dwell XE "Dwell"  time (specified in the DEFAULTDWELLTIME field in the BasicSettings.txt" BasicSettings.txt 
file) in the adjacent Dwell text box.  Un-checking a Stop checkbox will remove the adjacent dwell XE "Dwell"  time.  If the SELECTALLSTOPS field is set to Y in the BasicSettings.txt" BasicSettings.txt 
file, then all of the primary waypoints XE "primary waypoints"  will have the Stop checkbox checked and the Dwell pre-filled with the default dwell XE "Dwell"  time when the Add Trip XE "Add Trip"  window is accessed

g) Press the Add button to create the trip in the String View" String View
 area.  It may be necessary to zoom
 or pan
 to the time and location of the trip in order for it to be visible in the String View area

Populating the Extended XE "Extended"  Add Trip XE "Add Trip"  Fields

Enter information in the following fields to add a trip XE "trips"  when using the Add Trip XE "Add Trip"  Extended XE "Extended"  View window:

h) Enter the letters and/or numbers representing the trip XE "trips"  in the box labeled Train ID XE "Train ID" 
i) Indicate the type of train in the Type XE "Type"  dropdown box.  The various types available are defined in the WaypointsPositionsTracksSpeeds_name.txt XE "WaypointsPositionsTracksSpeeds_name.txt"  files

j) Select the train Direction.  The first option means that the sequence of waypoints XE "waypoints"  will be from the top of the list to the bottom (read down), and the second option means that the sequence of waypoints for the trip XE "trips"  will be from the bottom of the list to the top (read up).  The labels for these options are specified in the WaypointsPositionsTracksSpeeds_name.txt XE "WaypointsPositionsTracksSpeeds_name.txt"  files

k) Enter either the start or end time of the trip XE "trips"  in the Time field, and check the radio button for Start or End to indicate which time it is

l) Place checkmarks next to the start and end waypoints XE "start and end waypoints" 

 XE "waypoints"  for the trip XE "trips"  (only two checkboxes in this column should be checked at once).  The area to the left of these checkboxes shows the words Start and End to show how each checkmark has been interpreted.

m) Enter dwell XE "Dwell"  times for any waypoints XE "waypoints"  at which the train will stop.  The dwell XE "Dwell"  is the length of time that the train will be stopped.  Checking a Stop checkbox XE "Stop checkbox"  will enter the default dwell XE "Dwell"  time (specified in the DEFAULTDWELLTIME field in the BasicSettings.txt" BasicSettings.txt 
file) in the adjacent Dwell text box.  Un-checking a Stop checkbox will remove the adjacent dwell XE "Dwell"  time.  If the SELECTALLSTOPS field is set to Y in the BasicSettings.txt" BasicSettings.txt 
file, then all of the primary waypoints XE "primary waypoints"  will have the Stop checkbox checked and the Dwell pre-filled with the default dwell XE "Dwell"  time when the Add Trip XE "Add Trip"  window is accessed

n) When more than one track XE "tracks"  or siding XE "sidings"  exists between two stops, one of the tracks XE "tracks"  or sidings XE "sidings"  will be pre-selected.  If an unselected track XE "tracks"  is desired instead, it can be selected by clicking on the corresponding radio button

o) Press the Add button to create the trip in the String View" String View
 area.  It may be necessary to zoom
 or pan
 to the time and location of the trip in order for it to be visible in the String View area

See Appendix A for additional information on how the speeds XE "speeds"  are calculated for the trips.

Closing the Add Trip XE "Add Trip"  Windows

The Add Trip XE "Add Trip"  windows will remain open as trips are created to allow the user to make several new ones.  The Add Trip windows can be closed by:

1. Pressing the Close button

OR

2. Pressing the X in the top right corner of the Add Trip XE "Add Trip"  window

3.3.2 Selecting Trips

To select a trip XE "trips" , click on any part of the trip.  When a trip XE "trips"  is selected, the color changes and stop handles appear at the waypoints XE "waypoints"  and some speed XE "speeds"  change locations.  The stop handles XE "stop handles"  can be used for dragging the times of the trip XE "trips" , as described below.  Also, when a trip is selected, the tracks XE "tracks"  defined for that trip XE "trips"  are highlighted in the track diagram on the left side of the String View XE "String View"  area.

3.3.3 Highlighting Stop Handles

When the cursor arrow is positioned over a stop handle that is part of the selected trip, the color changes to show that it is ready to be adjusted (either by dragging or shifting by one-minute intervals).  If the times are displayed for the string, the time that corresponds with the highlighted stop handle will turn green with a black background.  If the speeds are displayed for the string, the speed for the segment above the highlighted stop handle will turn green with a black background.

3.3.4 Updating Trips Using the Update Trip XE "Update Trip"  Windows

There are several ways to modify trips XE "trips" .  One option is to use the Update Trip XE "Update Trip"  windows.  There are two Update Trip views, Condensed XE "Condensed"  and Extended XE "Extended" , which are described in further detail below.  These two windows look very similar to the Add Trip windows, but some of the options are disabled.

Update Trip XE "Update Trip"  Condensed XE "Condensed"  View

The Update Trip XE "Update Trip"  Condensed XE "Condensed"  View is shown below.
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This view provides access to only the primary waypoints XE "primary waypoints" 

 XE "waypoints" , so that the most common trip XE "trips"  information can be updated and viewed as quickly as possible.  This view does not provide information on the tracks XE "tracks"  used during the trip XE "trips"  or the speeds XE "speeds" .  If a trip XE "trips"  is updated in the Condensed XE "Condensed"  View it can continue to be updated or copied in the Condensed View, as long as it has never been modified in the Extended XE "Extended"  View.  

Update Trip XE "Update Trip"  Extended XE "Extended"  View

The Update Trip XE "Update Trip"  Extended XE "Extended"  View is shown below.
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This view provides access all of the waypoints XE "waypoints" , including the primary and secondary waypoints XE "secondary waypoints" .  This is a much more comprehensive view that provides the ability to see and update the tracks XE "tracks"  used during the trip XE "trips" , and also shows the speeds XE "speeds"  for all of the legs of the trip XE "trips" .  After a trip XE "trips"  is updated in the Extended XE "Extended"  View, it may never be updated or copied in the Condensed XE "Condensed"  View  

Accessing the Update Trip XE "Update Trip"  Windows

To access the Update Trip XE "Update Trip"  windows to modify an existing trip XE "trips" :

37.  Right mouse click on a trip, select Update Trip XE "Update Trip" , and then choose either the Condensed 
or Extended XE "Extended"  View
OR

38. Press the Update Trip XE "Update Trip"  toolbar button [image: image32.jpg]


 (after the desired trip XE "trips"  has been selected), and then choose either the Condensed 
or Extended XE "Extended"  View
OR

39. Select Update Trip XE "Update Trip"  from the Edit menu (after the desired trip XE "trips"  has been selected), and then choose either the Condensed 
or Extended XE "Extended"  View
Populating the Condensed XE "Condensed"  Update Trip XE "Update Trip"  Fields

Enter information in the following fields to modify an existing trip XE "trips"  when using the Update Trip XE "Update Trip"  Condensed XE "Condensed"  View window:

p) If necessary, modify the characters entered in the box labeled Train ID XE "Train ID" 
q) If necessary, modify the start or end time of the trip XE "trips"  and/or the Start or End radio button XE "Start or End radio button"  for that time

r) If necessary, enter, edit, or remove dwell XE "Dwell"  XE "Dwell"  times.  Checking a Stop checkbox XE "Stop checkbox"  will enter the default dwell XE "Dwell"  time (specified in the DEFAULTDWELLTIME field in the BasicSettings.txt" BasicSettings.txt 
file) in the adjacent Dwell XE "Dwell"  text box.  Un-checking a Stop checkbox will remove the adjacent dwell XE "Dwell"  time

s) Press the Update button to modify the trip in the String View" String View
 area.  It may be necessary to zoom
 or pan
 to the time and location of the trip in order for it to be visible in the String View area

Populating the Extended XE "Extended"  Update Trip XE "Update Trip"  Fields

Enter information in the following fields to modify an existing trip XE "trips"  when using the Update Trip XE "Update Trip"  Extended XE "Extended"  View window:

a) If necessary, modify the characters entered in the box labeled Train ID XE "Train ID" 
b) If necessary, modify the start or end time of the trip XE "trips"  and/or the Start or End radio button XE "Start or End radio button"  for that time

c) If necessary, enter, edit, or remove dwell XE "Dwell"  times.  Checking a Stop checkbox XE "Stop checkbox"  will enter the default dwell XE "Dwell"  time (specified in the DEFAULTDWELLTIME field in the BasicSettings.txt" BasicSettings.txt 
file) in the adjacent Dwell XE "Dwell"  text box.  Un-checking a Stop checkbox will remove the adjacent dwell XE "Dwell"  time

d) If necessary, modify which tracks XE "tracks"  or sidings XE "sidings"  are selected

e) Press the Update button to modify the trip in the String View" String View
 area.  It may be necessary to zoom
 or pan
 to the time and location of the trip in order for it to be visible in the String View area

See Appendix A for additional information on how the speeds XE "speeds"  are calculated for the trips.

Closing the Update Trip XE "Update Trip"  Windows

The Update Trip XE "Update Trip"  windows close automatically when the Update button is pressed.  To close the Update Trip windows without making any changes to the trip XE "trips" :

40. Press the Close button

OR

41. Press the X in the top right corner of the Update Trip XE "Update Trip"  window

3.3.5 Click and Drag Editing of Arrival Time XE "Click and Drag Editing of Arrival Time" 
Select the desired trip, and then left mouse click on a stop handle XE "stop handles"  and drag it horizontally to a different time.  This will modify the arrival time of the waypoint XE "waypoints" , and also update all later waypoints XE "waypoints" .  When many stop handles are close together, it can be helpful to highlight the desired one before clicking and dragging by positioning the cursor arrow over it until it changes color.

3.3.6 Click and Drag Editing of Dwell XE "Click and Drag Editing of Dwell" 

 XE "Dwell"  Time

If the Shift key is pressed on the keyboard while the left mouse button is clicked on a stop handle XE "stop handles"  and dragged to a different time, the length of time that the train is stopped at the station (dwell XE "Dwell"  time) will be adjusted.  When many stop handles are close together, it can be helpful to highlight the desired one before clicking and dragging by positioning the cursor arrow over it until it changes color.

3.3.7 Shifting Waypoints by One-Minute Intervals

Waypoint times can be adjusted by one-minute intervals.  First select the trip and then drag the cursor (without clicking) over the desired waypoint XE "waypoints"  to highlight it (it will turn green).  After that, the following can be done to shift the waypoint XE "waypoints"  times:

To shift the waypoint XE "waypoints"  times earlier by one-minute intervals:

42. Right mouse click on the trip (without highlighting a different waypoint XE "waypoints" ), and then select Move Trip Back One Minute XE "Move Trip Back One Minute" 
OR

43. Press the Move Trip Back One Minute XE "Move Trip Back One Minute"  toolbar button: [image: image33.jpg]



OR

44. Select Move Trip Back One Minute XE "Move Trip Back One Minute"  from the Edit menu

To shift the waypoint XE "waypoints"  times later by one-minute intervals:

45. Right mouse click on the trip (without highlighting a different waypoint XE "waypoints" ), and then select Move Trip Forward One Minute  XE "Move Trip Forward One Minute" 
OR

46. Press the Move Trip Forward One Minute XE "Move Trip Forward One Minute"  toolbar button: [image: image34.jpg]



OR

47. Select Move Trip Forward One Minute XE "Move Trip Forward One Minute"  from the Edit menu

Note:  All of the waypoints after the selected one will also show time adjustments during this process.

3.3.8 Setting a Trip Baseline XE "baseline" 
After a trip XE "trips"  has been created, all of the data values of the trip XE "trips"  can be stored as the “trip XE "trips"  baseline XE "baseline" .”  When a trip with a baseline XE "baseline"  is moved, the baseline stays in the original position to show where the trip was when the baseline was set.  Certain changes to the trip XE "trips"  are compared to the baseline values of the trip XE "trips" .  For example, when a stop handle XE "stop handles"  for a trip with a baseline is dragged, numbers are displayed to show the time difference between the new time and the baseline time for that location.  If changes to the trip XE "trips"  are not wanted, the trip can be returned to the trip XE "trips"  baseline values.  Although the regular string for the trip XE "trips"  can be adjusted, the black baseline string stays fixed unless a different position is set as the baseline.  

There are several ways to set the trip XE "trips"  baseline XE "baseline" :

48. Right mouse click on the trip and select Set Trip Baseline XE "baseline" 
OR

49. Press the Set Trip Baseline XE "baseline"  toolbar button: [image: image35.jpg]



OR

50. Select Set Trip Baseline XE "baseline"  from the Edit menu

Only one baseline XE "baseline"  can be stored for each trip XE "trips" .  To change the baseline, set the trip XE "trips"  values as desired for the new baseline, and then set the trip XE "trips"  baseline again. 

3.3.9 Returning a Trip to the Trip Baseline XE "baseline" 
When a trip XE "trips"  has a baseline XE "baseline" , and the values of the trip XE "trips"  have changed, there are several ways to return the trip XE "trips"  values to those in the trip XE "trips"  baseline:

51. Right mouse click on the trip and select Return Trip to Baseline XE "baseline" 
OR

52. Press the Return Trip to Baseline XE "baseline"  toolbar button: [image: image36.jpg]



OR

53. Select Return Trip to Baseline XE "baseline"  from Edit menu  

Note:  When this option is selected for a trip without a baseline XE "baseline" , it is returned to its original position.

3.3.10 Copying a Trip

The values of an existing trip XE "trips"  can be copied into a Copy Trip XE "Copy Trip"  window to make a new trip that is a duplicate of the existing trip.  Because two trips XE "trips"  are generally not supposed to be entirely identical, the Copy Trip window values can be modified before the new copy is “pasted” into the String View area XE "String View" .

In order to create a copy of a trip XE "trips" , a Copy Trip XE "Copy Trip"  window must be accessed.  There are two Copy Trip views, Condensed 
and Extended XE "Extended" , which are described in further detail below.  These two windows look very similar to the Add Trip windows, but some of the options are disabled.

Copy Trip XE "Copy Trip"  Condensed XE "Condensed"  View

The Copy Trip XE "Copy Trip"  Condensed XE "Condensed"  View is shown below.
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This view provides access to only the primary waypoints XE "primary waypoints" 

 XE "waypoints" , so that the most common trip XE "trips"  information can be copied, updated, and viewed as quickly as possible.  This view does not provide information on the tracks XE "tracks"  used during the trip XE "trips"  or the speeds XE "speeds" .  If a trip XE "trips"  is copied in the Condensed XE "Condensed"  View, it can continue to be updated or copied in the Condensed View, as long as it has never been modified in the Extended XE "Extended"  View.  

Copy Trip XE "Copy Trip"  Extended XE "Extended"  View

The Copy Trip XE "Copy Trip"  Extended XE "Extended"  View is shown below.
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This view provides access all of the waypoints XE "waypoints" , including the primary and secondary waypoints XE "secondary waypoints" .  This is a much more comprehensive view, that provides the ability to view and update the tracks XE "tracks"  used during the trip XE "trips" , and also shows the speeds XE "speeds"  for all of the legs of the trip XE "trips" .  After a trip XE "trips"  is copied in the Extended XE "Extended"  view, it may never be updated or copied with the Condensed XE "Condensed"  View.  

Accessing the Copy Trip XE "Copy Trip"  Windows

To access the Copy Trip XE "Copy Trip"  windows to copy an existing trip XE "trips" :

54. Right mouse click on a trip, select Copy Trip XE "Copy Trip" , and then choose either the Condensed 
or Extended XE "Extended"  View
OR

55. Press the Copy Trip XE "Copy Trip"  toolbar button [image: image39.jpg]


 (after the desired trip XE "trips"  has been selected), and then choose either the Condensed 

 or Extended XE "Extended"  View
OR

56. Select Copy Trip XE "Copy Trip"  from the Edit menu (after the desired trip XE "trips"  has been selected), and then choose either the Condensed 
or Extended XE "Extended"  View
Populating the Condensed XE "Condensed"  Copy Trip XE "Copy Trip"  Fields

The Copy Trip XE "Copy Trip"  windows have the fields that define the characteristics of the trip, so that the trip can be modified from the original.  When a trip XE "trips"  is copied using the Condensed XE "Condensed"  view:

a) If necessary, modify the characters entered in the box labeled Train ID XE "Train ID" 
b) If necessary, modify the start or end time of the trip XE "trips"  and/or the Start or End radio button XE "Start or End radio button"  for that time

c) If necessary, enter, edit, or remove dwell XE "Dwell"  times.  Checking a Stop checkbox XE "Stop checkbox"  will enter the default dwell XE "Dwell"  time (specified in the DEFAULTDWELLTIME field in the BasicSettings.txt" BasicSettings.txt 
file) in the adjacent Dwell text box.  Un-checking a Stop checkbox will remove the adjacent dwell XE "Dwell"  time

t) Pressing the Paste Copy button places the new copy in the String View" String View
 area.  It may be necessary to zoom
 or pan
 to the time and location of the trip in order for it to be visible in the String View area

Populating the Extended XE "Extended"  Copy Trip XE "Copy Trip"  Fields

The Copy Trip XE "Copy Trip"  windows have the fields that define the characteristics of the trip, so that the trip can be modified from the original.  When a trip XE "trips"  is copied using the Extended XE "Extended"  View:

a) If necessary, modify the characters entered in the box labeled Train ID XE "Train ID" 
b) If necessary, modify the start or end time of the trip XE "trips"  and/or the Start or End radio button XE "Start or End radio button"  for that time

c) If necessary, enter, edit, or remove dwell XE "Dwell"  times.  Checking a Stop checkbox XE "Stop checkbox"  will enter the default dwell XE "Dwell"  time (specified in the DEFAULTDWELLTIME field in the BasicSettings.txt" BasicSettings.txt 
file) in the adjacent Dwell text box.  Un-checking a Stop checkbox will remove the adjacent dwell XE "Dwell"  time

d) If necessary, modify which tracks XE "tracks"  or sidings XE "sidings"  are selected

u) Pressing the Paste Copy button places the new copy in the String View" String View
 area.  It may be necessary to zoom
 or pan
 to the time and location of the trip in order for it to be visible in the String View area

Closing the Copy Trip XE "Copy Trip"  Windows

The Copy Trip XE "Copy Trip"  windows close automatically when the Paste Copy button is pressed.  To close the Copy Trip windows without making a copy of the selected trip XE "trips" :

57. Press the Close button

OR

58. Press the X in the top right corner of the Copy Trip XE "Copy Trip"  window

3.3.11 Deleting a Trip

To remove a trip XE "trips" :

59. Right mouse click on the trip and select Delete Trip XE "Delete Trip" 
OR

60. Press the Delete Trip XE "Delete Trip"  toolbar button (after the desired trip XE "trips"  has been selected): [image: image40.jpg]



OR

61. Select Delete Trip XE "Delete Trip"  from the Edit menu (after the desired trip XE "trips"  has been selected)

Note:  When a trip XE "trips"  with a baseline XE "baseline"  is deleted, the baseline is also deleted.

3.3.12 Undeleting a Trip

It is sometimes possible to get back the most recently deleted trip XE "trips" .  To “undelete” a trip XE "trips" : 

62. Right mouse click in the String View" String View
 area and select Undelete Trip XE "Undelete Trip" 
OR 

63. Press the Undelete Trip XE "Undelete Trip"  toolbar button: [image: image41.jpg]



OR

64. Select Undelete Trip XE "Undelete Trip"  from the Edit menu

3.3.13 Show/Hide Trip Depart Times XE "Show/Hide Trip Depart Times" 
There are several ways to change whether the departure times for each stop handle XE "stop handles"  are visible for a selected trip:

65. Right mouse click on the trip and select Show/Hide Trip Depart Times XE "Show/Hide Trip Depart Times" 
OR

66. Press the Show/Hide Trip Depart Times XE "Show/Hide Trip Depart Times"  toolbar button (after the desired trip XE "trips"  has been selected): [image: image42.jpg]



OR

67. Select Show/Hide Trip Depart Times XE "Show/Hide Trip Depart Times"  from the View menu (after the desired trip XE "trips"  has been selected)

Note:  If the times are shown when the view is zoomed out to the original settings (such as when the view has been reset), only the times at the stop handles at primary waypoints will be displayed.  If the view of the tracks has been zoomed in, then times will display at every stop handle along the string when the times are shown.

3.3.14 Show/Hide Trip Speeds XE "Show/Hide Trip Speeds" 
There are several ways to change whether the speeds XE "speeds"  between stop handles XE "stop handles"  are visible for a selected trip:

68. Right mouse click on the trip and select Show/Hide Trip Speeds XE "Show/Hide Trip Speeds" 
OR

69. Press the Show/Hide Trip Speeds XE "Show/Hide Trip Speeds"  toolbar button (after the desired trip XE "trips"  has been selected): [image: image43.jpg]



OR

70. Select Show/Hide Trip Speeds XE "Show/Hide Trip Speeds"  from View menu (after the desired trip XE "trips"  has been selected)

Note:  If the speeds are shown when the view is zoomed out to the original settings (such as when the view has been reset

), only the average speeds between the primary waypoints will be displayed.  If the view of the tracks has been zoomed in, then the speeds between every stop handle along the string will display when the speeds are shown.

3.4 Track XE "tracks"  Restrictions XE "track restrictions" 
Track XE "tracks"  restrictions XE "track restrictions"  show when and where tracks XE "tracks"  will be taken out of service or require a lower speed XE "speeds"  than usual.  They are either displayed as rectangles in the String View" String View
 area that indicate the length of time and the stretch of track XE "tracks"  for the restriction or as a small colored band over the track XE "tracks"  layout shown on the left side of the String View XE "String View"  area.  

There are two types of track XE "tracks"  restrictions XE "track restrictions" :  Speed Restriction XE "speed restrictions"  and Track XE "tracks"  Out of Service XE "Track Out of Service" .  Speed restriction XE "speed restrictions"  markers are brown (or purple if they only apply when passing a certain location).  When a string for a trip XE "trips"  overlaps with a speed restriction XE "speed restrictions" , the application checks to see if the speed of the trip is faster than that of the speed restriction XE "speed restrictions" .  If so, the speed of the trip is automatically reduced so that the restricted speed will not be exceeded.  See Appendix A for additional information on how the speeds XE "speeds"  are calculated for the trips.  Track XE "tracks"  out of service markers are reddish in color, and do not automatically adjust the speeds of overlapping trips.

Note:  Disabled options exist as placeholders for additional functions (Update Track Restriction and Copy Track Restriction) that have not been implemented.

3.4.1 Adding Track XE "tracks"  Restrictions XE "Add Track Restriction"  XE "track restrictions" 
In order to add a new track XE "tracks"  restriction XE "track restrictions"  to the String View XE "String View"  area, an Add Track XE "tracks"  Restriction XE "Add Track Restriction"  window, which is shown below, must be accessed. 
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Accessing the Add Track XE "tracks"  Restriction XE "Add Track Restriction"  Window

To access the Add Track XE "tracks"  Restriction XE "Add Track Restriction"  window to create a new track XE "tracks"  restriction XE "track restrictions" :

71. Right mouse click in the String View" String View
 area and select Add Track XE "tracks"  Restriction XE "Add Track Restriction" 
OR

72. Press the Add Track XE "tracks"  Restriction XE "Add Track Restriction"  toolbar button 
[image: image45.png]



OR

73. Select Add Track XE "tracks"  Restriction XE "Add Track Restriction"  from the Edit menu

Populating the Add Track XE "tracks"  Restriction XE "Add Track Restriction"  Fields


Enter information in the following fields to add a track XE "tracks"  restriction XE "track restrictions" :

a) Use the Type XE "Type"  radio buttons to indicate whether the track XE "tracks"  restriction XE "track restrictions"  is a Track XE "tracks"  Out of Service XE "Track Out of Service"  or a Speed Restriction XE "speed restrictions" 
b) If it is a Speed Restriction, set the speed XE "speeds" (s) for freight and/or passenger trains.  (Note:  The Type XE "Type"  dropdown box in the Add Trip XE "Add Trip"  windows determines if the trip represents a passenger or freight train. The names listed in the Type dropdown box, which are defined in the WaypointsPositionsTracksSpeeds_name.txt XE "WaypointsPositionsTracksSpeeds_name.txt"  files, should all begin with the letters “Passenger” or “Freight,” so the speed restriction code can recognize which category applies for each of the train types XE "speed restrictions" .) 

c) Enter the day and time for when the track XE "tracks"  restriction XE "track restrictions"  will go into effect in the Start Day and Time fields, and enter the day and time for when the track XE "tracks"  restriction will end in the End Day and Time fields (the days and times that pre-fill in the Add Track Restriction XE "Add Track Restriction"  window are defined by the DEFAULTRESTRICTIONSTARTDAY, STARTRESTRICTIONSTARTTIME, DEFAULTRESTRICTIONENDDAY, DEFAULTRESTRICTIONENDTIME fields in the BasicSettings.txt" BasicSettings.txt 
file) 

d) Place checkmarks next to the start and end waypoints XE "start and end waypoints" 

 XE "waypoints"  for the track XE "tracks"  restriction XE "track restrictions" .  No more than two checkboxes in this column should be checked at once.  If only one is checked, that position will be the start and end for the track XE "tracks"  restriction.  In other words, the track XE "tracks"  restriction will only be in effect while the train is passing that point.  The area to the left of these checkboxes shows the words Start, End or Pass to show to show how each checkmark has been interpreted.

e) When more than one track XE "tracks"  exists between two stops, all of the tracks XE "tracks"  will be pre-checked.  Clicking on a selected checkbox will unselect it, and clicking on it again will reselect it.

f) Press the Add button to create the track restriction in the String View" String View
 area XE "String View" .  It may be necessary to zoom
 or pan
 to the time and location of the track restriction XE "track restrictions"  in order for it to be visible in the String View area

Closing the Add Track XE "tracks"  Restriction XE "Add Track Restriction"  Window

To close the Add Track XE "tracks"  Restriction XE "Add Track Restriction"  window XE "track restrictions" :

74. Press the Close button

OR

75. Press the X in the top right corner of the Add Track XE "tracks"  Restriction XE "Add Track Restriction"  window

3.4.2 Hide/Show Speed Restrictions  XE "Hide/Show Speed Restrictions" 
The track XE "tracks"  restrictions XE "track restrictions"  are initially visible in the String View XE "String View"  area spanning the times during which they will be in effect.  To reduce some of the visual clutter around the strings, the restrictions can be “hidden” so that their presence is only indicated along the track XE "tracks"  layout section of the screen.  To hide the restrictions, select Hide/Show Speed Restrictions XE "Hide/Show Speed Restrictions"  XE "speed restrictions"  from View menu.  Doing the same thing again will show the restrictions in the main part of the String View" String View
 area.

3.4.3 Selecting Track XE "tracks"  Restrictions XE "track restrictions" 
To select a track XE "tracks"  restriction, right mouse click on it and choose Select Track XE "tracks"  Restriction XE "track restrictions"  from the top of the menu that appears.

If the track XE "tracks"  restrictions XE "track restrictions"  are hidden, so that they are only visible over the track XE "tracks"  layout shown on the left side of the String View" String View
 area, you can still right mouse click on the time and location where the track XE "tracks"  restriction XE "track restrictions"  would be if it were visible to get the option to select it.  If it is difficult to locate the desired track XE "tracks"  restriction XE "track restrictions" , display them all using the Hide/Show Speed Restrictions XE "Hide/Show Speed Restrictions"  XE "speed restrictions"  option before selecting.

3.4.4 Deleting a Track XE "tracks"  Restriction XE "track restrictions" 
To remove a track XE "tracks"  restriction XE "track restrictions" , press the Delete Track XE "tracks"  Restriction XE "Delete Track Restriction"  toolbar button (after the desired track XE "tracks"  restriction XE "track restrictions"  has been selected): 
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3.4.5 Undeleting a Track XE "tracks"  Restriction XE "track restrictions" 
It is possible to get back the most recently deleted track XE "tracks"  restriction XE "track restrictions" .  To “undelete” a track XE "tracks"  restriction, press the Undelete Track XE "tracks"  Restriction XE "Undelete Track Restriction"  toolbar button: 
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3.5 GPS XE "GPS"  Tracking Data

If the GPS XE "GPS"  tracking system has been installed, and data has been entered in the database at Fulcrum Corporation (see Section 2.3), then GPS tracking information can be displayed in the String View" String View
 area XE "trips" .  The Railroad Traffic Planner application requests information from the database every minute, and places an orange rectangle in the String View" String View
 area at the corresponding time and mile number for each GPS position received from the database.  The orange rectangles are connected with gray lines to make the GPS strings (the gray connectors may not be visible when the view is zoomed out all of the way).  Below is an example of a GPS string:
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The Equipment ID XE "Train ID" , which is the set of letters and/or numbers used to identify the GPS XE "GPS"  string XE "trips" , is displayed at the beginning of each GPS string.  

The GPS XE "GPS"  strings look different than the strings that are generated by adding trips XE "trips" , since they are a different color and slightly transparent.  Also, the GPS strings are less linear, since they show the trains moving forwards and backwards while switching, whereas the strings created for planning can only show forward movements and dwells.  

Another feature of the GPS XE "GPS"  strings is that they sometimes have an open circle at the end, which indicates that although GPS data is still being received, the equipment is no longer on the line that is displayed in the String View" String View
 area.  This can occur if the vehicle goes onto another line, onto a very long siding XE "sidings"  that is not parallel to the track, or off the tracks XE "tracks"  entirely (such as in the case of a maintenance vehicle that can also go on roads).  

Unlike the strings that are created by adding trips XE "trips" , the GPS XE "GPS"  strings may not be modified, since they reflect the time and position information captured by the GPS tracking devices mounted on the equipment.   

3.5.1 Default Display of GPS XE "GPS"  Tracking Data

When the application is first opened, if the TRACKINGFEATURESON field in the BasicSettings.txt" BasicSettings.txt 
file is set to Y, GPS XE "GPS"  tracking data for today automatically displays in the String View" String View
 area.  The display includes all of the GPS positions received since the time specified in the DEFAULTTRACKINGSTARTTIME in the BasicSettings.txt" BasicSettings.txt 
file for all of the equipment with tracking devices on the current line.  As new GPS data become available, the new information is added to the String View" String View
 area, making the existing GPS strings longer.

3.5.2 Revising the GPS XE "GPS"  Tracking Data Options

To change the date and time range that specifies which GPS XE "GPS"  strings to display or to hide all GPS strings, the GPS Tracking Data Options XE "Add Trip"  window, which is shown below must be accessed.  
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Accessing the GPS XE "GPS"  Tracking Data Options XE "Add Track Restriction"  Window

To access the GPS XE "GPS"  Tracking Data Options XE "Add Trip"   XE "Add Track Restriction" window XE "track restrictions" :

76. Press the Show GPS XE "GPS"  Tracking Data Options  XE "Add Track Restriction" toolbar button [image: image50.jpg]o=
o




OR

77. Select Display GPS XE "GPS"  Tracking Data Options XE "Add Track Restriction"  from the View menu

Populating the GPS XE "GPS"  Tracking Data Options XE "Add Track Restriction"  Fields


The GPS XE "GPS"  Tracking Data Options window has three options, which each have a corresponding radio button.  When the system is set to Show Continuous Updates, the GPS strings start at the specified Start Date and Time and get longer throughout the day as new data is periodically becomes available.  There is a limit on how much data can be shown at once, so only today and the previous two dates are available when this option is selected.  Show Specific Time Interval allows you to display all of the GPS data from a particular date and time range.  Because this option does not involve retrieving additional data from the database throughout the day, dates that are further back in time are available, but only three days at a time should be requested with this option.  If the GPS data does not need to be displayed at all, the Hide Tracking Data option is available to remove it from view.

Enter information in the following fields when XE "trips"  using the GPS XE "GPS"  Tracking Data Options window:
a) Select the Show Continuous Updates radio button, the Show Specific Time Interval radio button, or the Hide Tracking Data radio button.

b) If the Show Continuous Updates radio button is selected, the corresponding Start Date may be specified using the dropdown box provided.  The default value that pre-fills for this field is today’s date.  

c) If the Show Continuous Updates radio button is selected, the corresponding Time text box enables you to adjust the starting point of the GPS XE "GPS"  data displayed in the String View" String View
 area.  The Time pre-fills with the value in the DEFAULTTRACKINGSTARTTIME in the BasicSettings.txt" BasicSettings.txt 
file, but that number can be modified (use military time using two digits for the hour and two digits for the minute; it is okay if the leading zeros are missing from the hour number)

d) If the Show Specific Time Interval radio button is selected, the Start Date and corresponding Time and End Date and corresponding Time must be entered.  Do not include more than three days of data in this range, or it will not all display properly in the String View" String View
 area

e) Press the OK button to have the GPS XE "GPS"  tracking data options take effect.   XE "String View" It may be necessary to zoom
 or pan
 to see the relevant section of the display in the String View" String View
 area

Closing the GPS XE "GPS"  Tracking Data Options XE "Add Track Restriction"  Window

To close the GPS XE "GPS"  Tracking Data Options XE "Add Track Restriction"  window without keeping the changes XE "track restrictions" :

78. Press the Cancel button

OR

79. Press the X in the top right corner of the GPS XE "GPS"  Tracking Data Options  XE "Add Track Restriction"  window

3.6 Schedules

There are several different things that can be done with schedules (sets of trips and track XE "tracks"  restrictions) XE "track restrictions"  that are created in the Railroad Traffic Planner.  The information in the String View" String View
 area can be printed at any time.  The trip and track XE "tracks"  restriction data can be saved, as Railroad Traffic Planner schedule files and then opened and worked on later.  Trips and track XE "tracks"  restrictions from saved schedule files can also be “imported,” to combine them with the ones that are currently shown.  An “export” feature transfers the trip information to a text document that can be viewed in a spreadsheet application.  

3.6.1 Printing

To print the information in the String View" String View
 area, the Print XE "Print"  window, which is shown below, must be accessed.
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Accessing the Print XE "Print"  Window

To access the Print XE "Print"  window to print the information in the String View" String View
 area:

80. Press the Print XE "Print"  String View XE "String View"  toolbar button: [image: image52.jpg]



OR

81. Select Print XE "Print"  String View XE "String View"  from the File menu

Populating the Print XE "Print"  Window Fields


To print a document:

a) Specify the printer that will be used in the Name dropdown 

b) Enter the number of copies desired the Number of copies box

c) Press the OK button to print

Here is some information about the other fields in this window:

· The Properties… button provides access to information related to the selected printer

· The Print XE "Print"  to file checkbox creates a file that is unreadable, so it should not be checked

· The only available option in the Print XE "Print"  range section is All

Closing the Print XE "Print"  Window

The Print XE "Print"  window closes automatically when the OK button is pressed.  To close the Print XE "Print"  window without printing:

82. Press the Cancel button

OR

83. Press the X in the top right corner of the Print XE "Print"  window

3.6.2 Saving Schedules

To save the trips XE "trips"  in a schedule (but not the GPS XE "GPS"  strings) for later use in the Railroad Traffic Planner, the Save Schedule XE "Save Schedule"  file browser XE "file browser"  window, which is shown below, must be accessed.

[image: image53.jpg][ severscreaueries o &l g

SampeSavedschedel
SempleSavedschectic?

Flogine:  [Sanvsaveascnaades soe

Flesottiee [airies

cancel

chedule Annotation
fMhis is a sauple scheaule.|





Accessing the Save Schedule XE "Save Schedule"  Window

To access the Save Schedule XE "Save Schedule"  window:

84. Press the Save Schedule XE "Save Schedule"  toolbar button: [image: image54.jpg]



OR

85. Select Save Schedule XE "Save Schedule"  from the File menu

Saving a Schedule in the SavedScheduleFiles Folder

The SavedScheduleFiles folder is defaulted in the Look In dropdown box when the Save Line Schedule XE "Save Schedule"  window is first accessed.  To save a file in this folder:

a) Enter a name in the File Name field

b) Enter a note in the Schedule Annotation XE "Schedule Annotation"  field, if desired.  This note will be visible in the Open Schedule" Open Schedule
 window, so it can be helpful for providing information about the schedule that will make remembering it easier later

c) Press the Save button to the right of the File Name field

See Appendix B for information on the additional functionality available in the file browser XE "file browser"  windows.

Closing the Save Schedule XE "Save Schedule"  Window

The Save Schedule XE "Save Schedule"  window closes automatically when the Save button is pressed.  To close the Save Schedule window without saving:

86. Press the Cancel button

OR

87. Press the X in the top right corner of the Save Schedule XE "Save Schedule"  window

3.6.3 Set Current Schedule As Default XE " Set Current Schedule As Default " 
After a schedule has been saved, it is possible to define that schedule as the default schedule XE "default schedule"  for that line by selecting Set Current Schedule XE "Save Schedule"  as Default XE " Set Current Schedule As Default "  from the File menu.  After that, when that line is selected from the Rail Map
 (or displayed when the application is first opened), the trips and track XE "tracks"  restrictions XE "track restrictions"  for that default schedule XE "default schedule"  automatically display in the String View XE "String View"  area and the name of the default schedule displays in the title bar.  If the title bar is blank when a line is selected, there is not a valid default schedule for that line. XE "default schedule" 
3.6.4 Opening Schedules 

To open an existing schedule, the Open Schedule XE "Open Schedule"  file browser XE "file browser"  window, which is shown below, must be accessed.
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Accessing the Open Schedule XE "Open Schedule"  Window

To access the Open Schedule XE "Open Schedule"  window:

88. Press the Open, Import Schedule XE "Open Schedule" 

 XE "Import Schedule"  toolbar button: [image: image56.jpg]


, and then choose Open Schedule
OR

89. Select Open Schedule XE "Open Schedule"  from the File menu

Opening Schedules in the SavedScheduleFiles Folder

The SavedScheduleFiles folder is defaulted in the Look In dropdown box when the Open Schedule XE "Open Schedule"  window is first accessed.  To open a schedule file from this folder:

a) Select the name of the desired schedule from the list of files and subdirectories.  (When the name has been selected, it is entered in the File name field and the Schedule Annotation XE "Schedule Annotation"  field displays the note that was saved with the file)

b) Press the Open button to the right of the File name field

The file selected must be a file created in the Railroad Traffic Planner application or else the Open operation will be unsuccessful.

See Appendix B

 for information on the additional functionality available in the file browser windows.

Closing the Open Schedule XE "Open Schedule"  Window

The Open Schedule XE "Open Schedule"  window closes automatically when the Open button is pressed.  To close the Open Schedule window without opening a file:

90. Press the Cancel button

OR

91. Press the X in the top right corner of the Open Schedule XE "Open Schedule"  window

3.6.5 Importing Schedules 

To import the trips and track XE "tracks"  restrictions XE "track restrictions"  from a saved schedule, the Import Schedule XE "Import Schedule"  file browser XE "file browser"  window, which is shown below, must be accessed.  When a schedule is imported, its trips and track XE "tracks"  restrictions are added to the String View XE "String View"  area along with any trips and track XE "tracks"  restrictions already present there.
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Accessing the Import Schedule XE "Import Schedule"  Window

92. Press the Open, Import Schedule XE "Import Schedule"  toolbar button: [image: image58.jpg]


, and then choose Import Schedule
OR

93. Select Import Schedule XE "Import Schedule"  from the File menu

Importing Schedules that are in the SavedScheduleFiles Folder

The SavedScheduleFiles folder is defaulted in the Look In dropdown box when the Import Schedule XE "Import Schedule"  window is first accessed.  To import a schedule file from this folder:

a) Select the name of the desired schedule from the list of files and subdirectories.  (When the name has been selected, it is entered in the File name field and the Schedule Annotation XE "Schedule Annotation"  field displays the note that was saved with the file)

b) Press the Merge button to the right of the File name field

The file selected must be a file created in the Railroad Traffic Planner application or else the import operation will be unsuccessful.

See Appendix B

 for information on the additional functionality available in the file browser windows.

Closing the Import Schedule XE "Import Schedule"  Window

The Import Schedule XE "Import Schedule"  window closes automatically when the Merge button is pressed.  To close the Import Schedule window without importing a schedule:

94. Press the Cancel button

OR

95. Press the X in the top right corner of the Import Schedule XE "Import Schedule"  window

3.6.6 Exporting Schedules 

Times corresponding with the primary waypoints
 XE "waypoints"  of trips XE "trips"  developed in the Railroad Traffic Planner can be exported to a file that can be opened in a spreadsheet application.  This allows them to be viewed in a traditional tabular schedule format, which makes it easy to print schedule documents and share them with other people that do not have access to the Railroad Traffic Planner.  When a schedule is exported, the schedule from which the file is created remains unchanged.  (Note:  GPS XE "GPS"  data strings cannot be exported this way.)

Here is an example of the layout of exported files:
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To export a schedule, the Export Schedule  XE "Export Schedule"  window, which is shown below, must be accessed.
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Accessing the Export Schedule XE "Export Schedule"  Window

To access the Export Schedule window, select Export Schedule XE "Export Schedule"  from the File menu

Exporting Schedules to the ExportedTextFiles Folder

The ExportedTextFiles folder is defaulted when the Export Schedule XE "Export Schedule"  window is first accessed.  To export a schedule file to this folder:

a) Enter a name in the File name field.  It is best to end the name with “.txt” to show that it is being saved as a text file (or “.xls” to indicate that it is being saved as a spreadsheet file)

b) Press the Export button to the right of the File name field

See Appendix B

 for information on the additional functionality available in the file browser windows.

Closing the Export Schedule XE "Export Schedule"  Window

The Export Schedule XE "Export Schedule"  window closes automatically when the Export button is pressed.  To close the Export Schedule window without exporting a schedule:

96. Press the Cancel button

OR

97. Press the X in the top right corner of the Export Schedule XE "Export Schedule"  window

3.6.7 Opening Exported Schedules in Microsoft Excel XE "Opening Exported Schedules in Microsoft Excel" 
There are several ways to open an exported file in Microsoft Excel.  One approach is to right mouse click on the file in Windows Explorer, and select Open With and then Microsoft Excel for Windows, as shown in the image below:
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3.6.8 Clearing Schedules

The Clear Schedule XE "Clear Schedule"  function is designed to remove the trips and track XE "tracks"  restrictions XE "track restrictions"  from the displayed schedule.  (This does not remove the GPS XE "GPS"  strings.  To hide the GPS Strings, access the GPS Tracking Data Options window described in Section 3.5.2.)

To access this function, press the Open, Import Schedule XE "Open Schedule" 

 XE "Import Schedule"  toolbar button: [image: image62.jpg]


, and then choose Clear Schedule XE "Clear Schedule" 
Note:  Sometimes this function must be selected more than once to remove all of the trips and track XE "tracks"  restrictions XE "track restrictions" .

3.6.9 Exiting the Railroad Traffic Planner
There are two ways to exit the Railroad Traffic Planner:

98. Select Exit from the File menu

OR

99. Press the X in the top right corner of the main application window (which contains the menu bar, toolbar, String View XE "String View"  area, etc.)

3.7 Help

3.7.1 User Guide

Select User Guide from the Help menu to access the Railroad Traffic Planner User Guide (this document).

3.7.2 About 

Select About Railroad Traffic Planner from the Help menu to access information about the Railroad Traffic Planner project.

4. Appendix A – Calculating Speeds

The Railroad Traffic Planner takes several things into account when calculating the speeds XE "speeds"  for a trip.  It considers the speeds specified in the WaypointsPositionsTracksSpeeds_name.txt XE "WaypointsPositionsTracksSpeeds_name.txt"  files, as well as the speeds specified by speed restrictions XE "speed restrictions" .  Strings are lines that represent the location of the train (specifically the very front of the train) at various points in time.  When one part of the string is supposed to be faster or slower than an adjacent part of the string, a period of acceleration or deceleration, defined by the SPEEDCHANGEDISTANCE in the WaypointsPositionsTracksSpeeds_name.txt XE "WaypointsPositionsTracksSpeeds_name.txt"  files, is included to account for the transition.  The process that determines the acceleration and deceleration also uses SPEEDCHANGEDISTANCE as a proxy for train length in the calculations.  It is designed to avoid ever having any part of the train exceed the speed limit, which could occur if the front of the train sped up before the back of the train reached the faster region.  Here are the rules for how speeds XE "speeds"  are calculated:

· When a slower region occurs after a faster one, the train must begin to decelerate one SPEEDCHANGEDISTANCE prior to the speed XE "speeds"  change boundary, so that it is down to the new speed when it gets there.

· When a faster region occurs after a slower one, the train must remain at the slower speed XE "speeds"  for one SPEEDCHANGEDISTANCE past the speed change boundary.  After that, the train should accelerate for one SPEEDCHANGEDISTANCE before reaching the new speed.

Note:  The speed calculations factor in acceleration and deceleration related to dwells when a trip is added, but not when a trip is updated or copied.

5. Appendix B – File Browser Features

The Railroad Traffic Planner uses file browser XE "file browser"  windows very similar to those used by other computer applications for saving, opening, importing and exporting schedules XE "Save Schedule" 

 XE "Open Schedule" 

 XE "Import Schedule" 

 XE "Export Schedule" .  Here are some of the features that have been included.

Selecting Different Directories

There are several ways to access a different directory for specifying file locations, such as the following:

· Select a different directory in the Look in dropdown box

· Press the Up One Level button 
[image: image63.png]


 to adjust the value in the Look in dropdown box to the name of the directory in which the previous value in the Look in dropdown box is located.

Changing the View of the File and Subdirectory List 

The List 
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 and Details 
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 buttons can be used to toggle between two ways of viewing the list of files and subdirectories in the directory shown in the Look in dropdown box.

Using an Existing File Name in the File Name Field

The File name field contains the name of the file to be saved, opened, imported, or exported.  Clicking once on the name of a file in the files and subdirectories list will put the name of that file into the File name field. 

Modifying the File and Subdirectory List

Changes can be made to the files and subdirectories listed.

· A new folder can be added by pressing the Create New Folder button 
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.  This folder will initially be called “New Folder” (this may have a number after it, if one or more new folders already exist).  

· To change the name of a file or folder, click twice slowly on it and then type over the existing name.  (Note:  If you double-click on the name, the function will be performed with the name that was clicked, and the window will close.) 

6. Appendix C – Known Bugs

Below is a list of known bugs and inconsistencies that might lead to problems.  Suggestions for working around them are provided when available.

Menu Bar

Here are the known bugs related to the menu bar at the top of the screen.

100. When functions that open a window are accessed from the menu bar, the new window usually goes behind the main Railroad Traffic Planner window

Use the toolbar or the right mouse click menus for these functions, instead of the menu bar, to avoid this problem.        

Access the windows that are behind the main Railroad Traffic Planner window using the Microsoft Windows task bar.

101. Menu options are not always disabled properly

Use either the toolbar or the right mouse click menus, instead of the menu bar, for inappropriately disabled functions.    

Adjusting the View

When problems with adjusting the view (String View navigation) occur, the easiest way to resolve them is to reset the view and then try again.  Here are some known bugs related to adjusting the view.

102. The view goes backwards sometimes when you click and drag to adjust the view or if you drag the slider arrows to the wrong side of the slider bar

Move the slider arrows so that they are pointing at each other.

103. When the view is zoomed way in (less than ½ hour visible), the pan XE "pan"  arrows don’t work. 

Zoom XE "zoom"  out a bit and try again.

104. Sometimes strings vanish when the view is moved from side to side.

Move the view from side to side to a point at which they are visible again.

Adding, Updating and Copying Trips

Here are some things to consider if Add Trip XE "Add Trip" , Update Trip XE "Update Trip"  or Copy Trip XE "Copy Trip"  does not work.

105. The Add Trip XE "Add Trip" , Update Trip XE "Update Trip"  or Copy Trip windows require leading zeros for the hour (some of the other windows do not).

106. Add Trip XE "Add Trip" , Update Trip XE "Update Trip"  and Copy Trip XE "Copy Trip"  will not work correctly without two numbers for hour in the Time field.

Some other windows do not require leading zeros for the hour, but these ones do.

107. Specifying an end time in the Add Trip window may not result in the proper times if there are speed restrictions.

Make sure the final Arrive time matches your expectations.  If not, figure out a start time that will result in the proper end time and use that instead.

108. If sidings XE "sidings"  are selected when a trip XE "trips"  is added with the Extended XE "Extended"  Add Trip XE "Add Trip"  window, the sidings do not appear to be selected when the Update Trip XE "Update Trip"  or Copy Trip XE "Copy Trip"  windows are opened for that trip.

109. Times do not calculate in the Add Trip XE "Add Trip" , Update Trip XE "Update Trip"  or Copy Trip XE "Copy Trip"  windows if selected stops are too close together.

This problem occurs if the stops are very close (such as less than 0.1 miles apart). How close is too close depends on the value of the SPEEDCHANGEDISTANCE in the WaypointsPositionsTracksSpeeds_name.txt XE "WaypointsPositionsTracksSpeeds_name.txt"  file.

One workaround is to only add one of the stops in the Add Trip XE "Add Trip" , Update Trip XE "Update Trip"  or Copy Trip XE "Copy Trip"  window and then shift-drag a dwell in the at the other location in the String View XE "String View"  area after the string has been created.

110. Times may not display when adding a trip XE "trips"  if the first or last speed change specified in the WaypointsPositionsTracksSpeeds_name.txt XE "WaypointsPositionsTracksSpeeds_name.txt"  is too close to the start or end of the list of waypoints.

One workaround is too add extra waypoints before or after so that the speed change is not so close to the beginning or end of the list.

111. If the WaypointsPositionsTracksSpeeds_name.txt XE "WaypointsPositionsTracksSpeeds_name.txt"  file has a 0 where there should be a speed XE "speeds" , times show as 3647:00:00 from that point forward in the Add Trip XE "Add Trip"  window.

112. The application may hang when adding a trip XE "trips"  if the mile numbers for the waypoints XE "waypoints"  are out of sequence in the WaypointsPositionsTracksSpeeds_name.txt XE "WaypointsPositionsTracksSpeeds_name.txt"  file.

113. The application will hang trying to calculate the speeds if two waypoints XE "waypoints"  in the WaypointsPositionsTracksSpeeds_name.txt XE "WaypointsPositionsTracksSpeeds_name.txt"  file have the same mile numbers.

114. Times may not display when adding a trip XE "trips"  if the waypoint XE "waypoints"  names in the WaypointsPositionsTracksSpeeds_name.txt XE "WaypointsPositionsTracksSpeeds_name.txt"  file are not unique.

115. The tracks and waypoints do not display if there are more than 60 primary waypoints. 

116. The buttons at the bottom of the Condensed XE "Condensed"  Add Trip XE "Add Trip" , Update Trip XE "Update Trip"  and Copy Trip XE "Copy Trip"  windows are not visible if there are more than 37 primary waypoints XE "primary waypoints" 

 XE "waypoints" . XE "primary waypoints" 
The windows resize to fit the number of primary waypoints XE "primary waypoints"  in the list, but if there are too many primary waypoints XE "waypoints" , the bottom gets cut off.

If the buttons are not visible when there are less than 37 waypoints XE "waypoints" , try dragging the window up to show the bottom part where the buttons are.

The optimal screen resolution for the monitor is 1280x1024.  If it is less than that, the bottom of the windows may not be visible.

117. The calculations in the Add Trip XE "Add Trip"  window include acceleration and deceleration adjacent to the dwells.  The Update Trip XE "Update Trip"  and Copy Trip XE "Copy Trip"  windows do not adjust the acceleration and deceleration if a dwell is added or removed.

Viewing Trips

Here are some problems that can occur when you are viewing trips XE "trips"  in the String View XE "String View"  area.

118. Sometimes trips make a zigzag pattern where some of the speeds XE "speeds"  are positive and some are negative.

This can happen if you drag a waypoint XE "waypoints"  so the trip is vertical and the speed XE "speeds"  goes to infinity.

This can also happen when adjusting a waypoint XE "waypoints"  by one-minute intervals.  

Pressing Return Trip to Baseline can sometimes set the trip back to the position it was in when it was originally created, but other problems may occur afterwards, so it is often better to create another trip and delete the incorrect one.  

119. Selecting Return Trip to Baseline in the right-mouse click menu over a trip leaves a horizontal line connecting the top of the new and old trip positions. 

Use this function from the toolbar or menu bar instead.
Track Restrictions

Here are some problems related to track restrictions XE "track restrictions" .

120. Sometimes the speeds XE "speeds"  don’t calculate properly when a trip is added over a speed restriction. XE "speed restrictions" 
If this happens, try adding the speed XE "speeds"  restriction XE "speed restrictions"  over the trip.

121. Although a trip XE "trips"  will get slower if a speed XE "speeds"  restriction XE "speed restrictions"  is placed over it, it will not return to the faster speed when the speed restriction is removed.

When a speed XE "speeds"  restriction XE "speed restrictions"  and trip XE "trips"  overlap, the trip adjusts the speed specified in the speed restriction (if it is slower than the original speed for that section of the trip).  If you want the fast speed again, you must either drag the trip to the speed you want, or make a new trip.

Printing

Sometimes there are problems related to printing XE "track restrictions" .

122. String View XE "String View"  area does not print properly with certain computers/printers.  One workaround is to press the Print Screen key on the keyboard while viewing the desired information.  After that, paste the image into another application (such as Microsoft Word or a graphics program) and then print the image using that application.

Missing Error Messages

Many of the error messages commonly found in computer applications have not been included.  

123. It does not prompt you to save your changes if you close the application.

124. It does not notify you if a name you specify will overwrite an existing file when saving or exporting. 

125. It does not ask if you are sure you want to delete a trip XE "trips"  or a track restriction. XE "track restrictions" 
An Undelete option is available for both, so you can retrieve the most recently deleted one, but this doesn’t always work. 

126. It does not display errors if entries are invalid (such as letters entered in a time field, or a start time that is earlier than the end time).

127. It does not notify you that GPS XE "GPS"  data isn’t getting through if the Internet connection is down.

Note:  If something is not working correctly, clues to the problems might be available in the black command screen window called “Shortcut to RTP” that is opened when the application is launched.

7. Glossary

	Term
	Definition

	Baseline
	After a trip XE "trips"  has been created, all of the data values of the trip XE "trips"  can be stored as the “trip XE "trips"  baseline XE "baseline" .”  When a trip with a baseline XE "baseline"  is moved, the baseline (black version of the trip) stays in the original position to show where the trip was when the baseline was set.  Certain changes to the trip XE "trips"  are compared to the baseline values of the trip, such as the difference between the new time and the baseline time for a location  XE "trips" when its stop handle XE "stop handles"  is dragged.  If changes to the trip XE "trips"  are not wanted, the trip can be returned to the trip XE "trips"  baseline values.  The black baseline trip stays fixed unless a different position is set as the baseline.  

	Checkbox
	A control used to select options on the screen.  When a checkbox has a checkmark in it (
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) the corresponding option is selected, and when it does not (
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) the corresponding option is not selected.

	Condensed XE "Condensed"  View
	The more simple type of window available when adding, updating and copying trips XE "trips" .  It only shows some of the most critical information about the trip XE "trips" .  It does not provide three things that are available in the Extended XE "Extended"  View: secondary waypoints XE "secondary waypoints" , XE "waypoints"  tracks XE "tracks" , and speeds XE "speeds" .  Trips may not be accessed with the Condensed XE "Condensed"  View if they were added or updated in the Extended View.

	Default dwell
	The default dwell XE "Dwell"  is the length of time that displays in the Dwell column when the adjacent Stop checkbox XE "Stop checkbox"  is checked in the Add Trip, XE "Add Trip"  Update Trip XE "Update Trip"  and Copy Trip XE "Copy Trip"  windows.  The number of minutes and seconds is specified in the DEFAULTDWELLTIME field in the BasicSettings.txt" BasicSettings.txt 
file.

	Default schedule XE "default schedule" 
	A default schedule XE "default schedule"  can be defined for each line by selecting Set Current Schedule XE "Save Schedule"  as Default XE "Set Current Schedule As Default"  from the File menu after the schedule has been saved.  When a line is clicked on the Rail Map XE "Rail Map" , the trips and track XE "tracks"  restrictions XE "track restrictions"  for the default schedule XE "default schedule"  for that line display in the String View XE "String View"  area.

	Default view
	The hours and track sections visible in the String View XE "String View"  area when the application is first opened or the view is reset.  The start and end hours for the default view are defined in the BasicSettings.txt XE "BasicSettings.txt"  file

	Disabled
	When an option is disabled, it is grayed out and cannot be selected.  Usually this occurs when that option is not valid under the current circumstances (for instance, it is not possible to select the option to Update Trip XE "Update Trip"  unless a specific trip XE "trips"  has been selected).  Some of the functionality that has not yet been incorporated has disabled options as placeholders.

	Double-click
	Click the left mouse button twice very quickly.

	Dropdown box
	A control used to select options from a list.  Dropdown boxes have an arrow on the right hand side to indicate that additional options are available.  When the dropdown box is clicked, the options display and the desired one can be selected.  For example, the Type XE "Type"  option in the Add Trip XE "Add Trip"  windows is a dropdown box: 
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After it is clicked, the full list displays, so that the desired one can be selected:
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	Dwell XE "Dwell" 
	Time spent at a waypoint XE "waypoints"  when the train is stopped.

	Export XE "Export Schedule" 
	The primary waypoint
 XE "waypoints"  times for all of the trips in a schedule can be placed in a text file that can be opened in a spreadsheet application.

	Extended XE "Extended"  View
	The more detailed view available when adding, updating and copying trips XE "trips" .  This view provides access to all of the waypoints XE "waypoints" , including the primary XE "primary waypoints"  and the secondary waypoints XE "secondary waypoints" .  It provides the ability to view and update the tracks XE "tracks"  used during the trip XE "trips" , and also shows the speeds XE "speeds"  for all of the legs of the trip XE "trips" .  When a trip XE "trips"  has been added or updated in the Extended XE "Extended"  View, it cannot be updated or copied in the Condensed XE "Condensed"  View.

	File browser XE "file browser"  window
	File browser XE "file browser"  windows show the files that are available on the computer.  In this application, file browser XE "file browser"  windows are used to Save, Open, Import and Export schedules XE "Save Schedule" 

 XE "Open Schedule" 

 XE "Import Schedule" 

 XE "Export Schedule" .

	Import XE "Import Schedule" 
	When a schedule is imported, its trips and track XE "tracks"  restrictions XE "track restrictions"  are added to the String View XE "String View"  area along with any trips and track XE "tracks"  restrictions already present there.

	Line
	A set of tracks XE "tracks"  and sidings XE "sidings"  that follow along a series of waypoints XE "waypoints"  in a certain sequence.  The Rail Map XE "Rail Map"  provides the ability to choose which line to display in the String View XE "String View"  area.

	Menu bar
	The menu bar includes the controls at the top of the screen labeled, File, Edit, View and Help.  Each of them has a set of functions that can be performed.

	Mile markers
	The mile numbers of the various sections of track XE "tracks"  are shown in the Track XE "tracks"  Slider XE "Track Slider" , and along the right edge of the String View XE "String View"  area.

	Pan XE "pan" 
	Move the view from side to side or up and down.

	“Pass” Track Restriction
	A track restriction can be defined with only one waypoint XE "waypoints" , which means that the restriction is only in effect when passing that location.  The word “Pass” displays in the Start/End column of the Add Track Restriction XE "Add Track Restriction"  window when these are created.  These track restrictions XE "track restrictions"  display as a purple horizontal line in the String View XE "String View"  area.

	Primary waypoints XE "waypoints" 

 XE "primary waypoints" 
	The highest priority waypoint XE "waypoints"  names are called primary waypoints XE "primary waypoints" .  These are included in the Track Slider
 XE "Track Slider"  and in the Condensed XE "Condensed"  views of the Add Trip XE "Add Trip" , Update Trip XE "Update Trip"  and Copy Trip XE "Copy Trip"  windows.  Although all waypoint XE "waypoints"  names are shown in the String View XE "String View"  area, and in the Extended 
views of the Add Trip, Update Trip and Copy Trip windows, the primary waypoint XE "waypoints" 

 XE "primary waypoints"  names are bolder and/or darker in these places.  Whether a waypoint is primary or secondary is defined in the WaypointsPositionsTracksSpeeds_name.txt XE "WaypointsPositionsTracksSpeeds_name.txt"  files.

	Radio button
	A control used to select one from a group of options.  In the example below, either Start XE "Outbound"  or End can be selected XE "Inbound" , but never both, so if one gets selected the other gets deselected.
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	Rail Map XE "Rail Map" 
	Window that allows the user to select the line displayed in the String View XE "String View"  area.  When a line is selected on the Rail Map XE "Rail Map" , the trips and track XE "tracks"  restrictions XE "track restrictions"  from the default schedule XE "default schedule"  for that line (if there is one) will display.  The Rail Map characteristics are defined in the BasicSettings.txt XE "BasicSettings.txt"  file.

	Right mouse click menu
	When the right mouse button is pressed when the cursor is over the String View XE "String View"  area, a menu will display, such as the following:
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There are different right mouse click menus depending on whether the cursor is positioned over a trip, a track XE "tracks"  restriction, XE "track restrictions"  or just the String View XE "String View"  background.

	Schedule annotation
	When saving a schedule, text can be entered in the Schedule Annotation XE "Schedule Annotation"  field to describe the schedule that is being saved.  This text is visible when opening schedules.

	Secondary waypoints XE "waypoints" 

 XE "secondary waypoints" 
	The lower priority waypoint XE "waypoints"  names.  These are not included in the Track Slider
 XE "Track Slider"  or the Condensed XE "Condensed"  views of the Add Trip XE "Add Trip" , Update Trip XE "Update Trip"  and Copy Trip XE "Copy Trip"  windows.  They are lighter and/or less bold than the primary waypoint XE "waypoints" 

 XE "primary waypoints"  names in the String View XE "String View"  area and the Extended XE "Extended"  views of the Add Trip, Update Trip and Copy Trip windows.  Whether a waypoint is primary or secondary is defined in the WaypointsPositionsTracksSpeeds_name.txt XE "WaypointsPositionsTracksSpeeds_name.txt"  files.

	Speed
	The average speed for each leg of a trip XE "trips"  is visible in the Extended XE "Extended"  views of the Add Trip XE "Add Trip" , Update Trip XE "Update Trip"  and Copy Trip XE "Copy Trip"  windows.  It can also be displayed for individual trips by selecting the trip and then selecting the toolbar, menu bar or right mouse click menu option Show/Hide Trip Speeds XE "Show/Hide Trip Speeds" .  The default speeds XE "speeds"  for each section of track XE "tracks"  are defined in the WaypointsPositionsTracksSpeeds_name.txt XE "WaypointsPositionsTracksSpeeds_name.txt"  files.  The speeds of the trips are also influenced by speed restrictions XE "speed restrictions"  in the schedules.

	Stop handles
	Small squares at the waypoints XE "waypoints"  (and where the acceleration or deceleration begins for certain speed changes) that display on a trip when it is selected.  They can be d XE "stop handles" ragged to adjusts the trip’s times and speeds. XE "speeds"   When the view is zoomed XE "zoom"  out all the way, only the stop handles at primary waypoints XE "primary waypoints"  are visible.

	String
	A line representing the times and locations of a train during the course of a trip XE "trips" .

	String View XE "String View"  area
	Section of the main application window that contains the trip and track XE "tracks"  restriction XE "track restrictions"  images. 

	Submenu
	A menu that is available by bringing the cursor over an option with an arrow on the right hand side in the menu bar and right mouse click menus.  For example, a submenu exists for selecting the Condensed XE "Condensed"  and Extended XE "Extended"  views when adding trips XE "trips" :
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	Time Slider XE "Time Slider" 
	Control for adjusting which hours are visible in the String View XE "String View"  area.

	Toolbar
	Section near the top of the screen with buttons with images on them.  If you place the mouse arrow over the button without pressing the buttons, a tool tip will appear to indicate the purpose of the button.

	Track XE "tracks"  Slider XE "Track Slider" 
	Control for adjusting which miles, tracks XE "tracks" , and major waypoints XE "waypoints"  that are visible.

	Tracks
	A pictorial representation of the tracks XE "tracks"  and sidings XE "sidings"  is provided in the Track Slider
, XE "Track Slider"  the String View XE "String View"  area, and in the Extended XE "Extended"  views of the Add Trip XE "Add Trip" , Update Trip XE "Update Trip"  and Copy Trip XE "Copy Trip"  windows.  When a trip is selected, the tracks defined for that trip XE "trips"  are highlighted in the track diagram on the left side of the String View area.

	Train ID XE "Train ID" 
	The set of letters or numbers used to identify the train trip XE "trips" .

	Train Type XE "Type" 
	The timing files are set up to allow for different types of trains to have different average times (for example, passenger trains are faster than freight trains).  The train types and their timings can be customized using the WaypointsPositionsTracksSpeeds_name.txt XE "WaypointsPositionsTracksSpeeds_name.txt"  files.

	Trip
	A scheduled train journey.  The strings are visual representations of the trips XE "trips" .

	Waypoints
	Locations such as stops, interlockings and milepost numbers, which are specified in the WaypointsPositionsTracksSpeeds_name.txt XE "WaypointsPositionsTracksSpeeds_name.txt"  files.  They are displayed on the Track Slider
, XE "Track Slider"  the left side of the String View XE "String View"  area, and the Add Trip XE "Add Trip" , Update Trip XE "Update Trip"  and Copy Trip XE "Copy Trip"  windows.

	Zoom XE "zoom" 
	Adjust the view to show more or less of the overall area.
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Whether GPS tracking features are enabled1

Default time of day the GPS tracking data should begin showing2

The first hour shown in the Time Slider3

The last hour shown in the Time Slider3

The first hour visible in the String View initially3

The last hour visible in the String View initially3

Whether all primary waypoints default as stops when adding a trip1

Number of minutes that defaults when a waypoint gets marked as a “stop”

Start Time that defaults in the Add Track Restriction window2

Start Day that defaults in the Add Track Restriction window4

End Time that defaults in the Add Track Restriction window2

End Day that defaults in the Add Track Restriction window4

Labels for the fields to the right (do not modify)

File containing small Rail Map image for the main window

Number (based on the list below with the count starting at 0) indicating which line will display first when the application is opened

Number of files in the list below (the next 5 lines show the setup if only 1 included)

Name of file that specifies the speeds (format must be “WaypointsPositionsTracksSpeeds_” then the line name)

Line name

Number of segments for this line in the list directly below (several versions of the 2nd line below can be included if the line is not straight)

Direction of selection marks (LeftDiag, RightDiag, Horizontal, Vertical)

Boundary of the selection rectangles (pixels for left, top, width, height)

Left, top, right, bottom pixel coordinates for the segment

File containing Rail Map window image

3 Hour number (count up from 0, which is midnight for Day 0)

2 Time should be in hhmm format (leading zeros can be missing)

4 Day number (from -1 to 2)

1 Enter Y for yes or N for no

Name of GPS Tracking System Server or “X” if none

Name of GPS Tracking System Port or “X” if none





TRACKINGFEATURESON N

TRACKINGSERVER X
TRACKINGPORT X
DEFAULTTRACKINGSTARTTIME
DEFAULTSLIDERSTARTHOUR

DEFAULTSLIDERENDHOUR 72
DEFAULTSTRINGVIEWSTARTHOUR 0
DEFAULTSTRINGVIEWENDHOUR 27
SELECTALLSTOPS N
DEFAULTDWELLTIME 15
DEFAULTRESTRICTIONSTARTDAY 0
DEFAULTRESTRICTIONSTARTTIME 0
DEFAULTRESTRICTIONENDDAY 0
DEFAULTRESTRICTIONENDTIME 2400
RAILMAPIMAGEFILE SampleLarge jpg
RAILMAPSTANDINIMAGEFILE SampleSmall jog
LOADDEFAULTRAILLINENUMBER 0
RAILLINEFILES 1
WaypointsPositionsTracksSpeeds_Sample txt

RAILMAPDATA

SAMPLE 1
SELECTIONRECT 14477404 232

LeftDiag 266 203|383 215
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Labels for the fields to the right (do not modify)

Currently this value must be 3

Number of train types included in the area to the left

Labels for the fields below (do not modify)

PRIMARYORSECONDARYWAYPOINT = Which type of waypoint is in the row:  enter P for primary (where stops are most likely to occur) and S for secondary

MILENUMBER = the position of the waypoint along the line

USED = whether or not the row is included when running the application

TRACKS = Code for the presence or absence of tracks or sidings

WAYPOINTNAME = name of location along the track

Word that displays for going down the list of waypoints when adding a trip

Word that displays for going up the list of waypoints when adding a trip

Labels for the fields to the right (do not modify)

Label for the field to the right (do not modify)

Name of the train type, which must start with either “Freight-” or “Passenger”

Typical distance for acceleration and deceleration

Typical speeds for this train type for each direction (Up, Down) and track (1, 2, 3).  Set speed to 0 when there is no corresponding track for the column

Default tracks for this train type for each direction (enter T1, T2 or T3)

Repeat the columns above for each train type

Label for the field to the right (do not modify)

SWITCHES = Code for the presence or absence of switches
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